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1–Getting Started
Welcome to the Portfolio 4.0 Content Publisher’s Manual. This manual is meant to walk you
through the process of creating CD-ROMs containing a Portfolio catalog and your files.

About this manual
The process of creating a CD-ROM with a Portfolio catalog is not terribly complex; howev-
er, there are certain pitfalls you may encounter if you are unfamiliar with the process.
Therefore, it is recommended that you familiarize yourself with the entire process outlined in
this manual before you burn your first CD-ROM.  If you are already familiar with Portfolio
and the CD burning process, you may be able to skip certain sections of this manual.

The manual is laid out to walk you through the entire process of creating a presentation-
quality CD-ROM.  
• For information on collecting your source files and source file preparation, see Chapter 2,

“Preparing your Files.”
• For information on creating the Portfolio catalog, see Chapter 3, “Creating the Catalog.”
• For information on the actual process of burning the CD-ROM, see Chapter 4, “Burning a

Portfolio CD-ROM.”

Content Publisher’s system recommendations
• Macintosh® PowerPC® (or equivalent) with MacOS® 7.5.5 (or later).

Though this manual will instruct you how to create fully cross-platform Portfolio CD-
ROMs, this manual expects that you will be publishing the master CD on a Macintosh. A
number of features and instructions outlined in this manual either pertain exclusively to
the Macintosh platform or are significantly different on the Windows platform.

• CD-ROM drive
This is necessary for testing the master CD.  Most computers have built-in CD-ROM dri-
ves. Many CD-R drives also include the ability to mount existing CDs.

• CD-R drive
Extensis does not recommend any particular brand of CD burners. The primary differ-
ence in CD-R drives is the write speed.  A 4x burner  will write the same CD twice as
fast as a 2x burner. A full CD-ROM can take upwards of an hour to burn on a 2x drive,
so this can result in significant time savings.  Also research the reliability of any drive
you may be purchasing; since you will be using this drive to master your CD, you want
to make sure it produces a quality master.

• External hard drive or an Iomega® Jaz® drive  (large enough to contain the contents of
your CD-ROM).
Creating a Portfolio CD requires a volume for staging production. This volume can either
be a hard drive, a temporary partition, or fast removable media, such as a Jaz® drive. Jaz
cartridges are convenient, since you can remove the cartridge, store it in a safe place, and
update it in the future for a new CD. Some CD writing software allows you to create a
temporary partition on your hard drive for the duration of the burn process.

• CD-ROM burning software
Extensis does not recommend any particular CD-writing software. This manual does use
Adaptec™ Toast® as its example; however, most software should perform similarly.  Read
Chapter 4, “Burning a Portfolio CD-ROM,” for specific features that are used in creating
a Portfolio CD-ROM.

• Windows 95/98 and/or a Windows NT 4.0 system with CD drive
If you are burning a cross-platform CD, this is necessary for testing. Do not assume that
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a CD that works correctly on a Macintosh will work properly on a Windows PC (there
are many reasons why it may not). Do not rely upon Windows CD mounting software for
the Macintosh or Windows emulators to test the CD, either.

Cross-Platform Considerations
One of the strengths of Portfolio is its ability to create catalogs that can be read by
Macintosh, Windows 95, and Windows NT 4.0 systems.  Most Macintosh CD-ROM burning
systems allow you to create hybrid CDs which are readable on both Mac and Windows sys-
tems.

For the most part, creating a hybrid CD follows the same steps as creating a Mac CD, but
there are some special considerations that need to be made in order for the CD to work prop-
erly on both platforms. Look throughout this manual for the symbol to the left for issues that
are specific to hybrid CDs.

Using Technical Support
For questions regarding using Portfolio, please refer to the Portfolio Users’s Guide first—it
describes all of Portfolio’s features and basic operations. In addition, you can find answers to
frequently asked questions and troubleshooting tips on the Portfolio page of the Extensis
World Wide Web site at www.extensis.com/products/portfolio.

If you have questions regarding creating a Portfolio CD-ROM that are not covered in this
manual, please contact Extensis technical support via one of the following methods:
• Telephone:  (503) 274-7030
• Fax:  (503) 274-0530
• E-mail:  support@extensis.com

Technical support is available Monday through Friday 8:00 a.m. to 5:00 p.m. Pacific time. 
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2—Preparing your Files

This chapter covers the process of collecting your files and laying them out on a temporary
volume in preparation for cataloging and the CD burn process.

Compiling Content

You can fit approximately 650 MB of information on a CD-ROM.  Of this space, remember
that you will need to use some space for the Portfolio browser and the Portfolio catalog. 

A good rule of thumb for catalog size is 10k per record.  Therefore, if you are planning a
catalog with 5,000 items in it, you should anticipate that the catalog will be roughly 50MB
in size.  Note that the actual size will vary, based on the number of keywords, custom fields,
the size of the description text, and the size of the thumbnails stored in the catalog.

If you are creating a hybrid CD, you will need to leave space for the Windows Portfolio
Browser as well. The space requirements for this can vary between 5MB and 15MB.
However, you will not need addtional space for the images and catalog; this is one of the
advantages of Portfolio and hybrid CDs.

Example: You are planning on creating a hybrid CD-ROM with 5,000 low resolution
JPEG (approximately 100k each) images. Below are the calculations you
would make to determine whether these images will fit on the CD-ROM:

Images:  5000 x 100k = 500MB

Catalog:  5000 x 10k = 50MB

Mac Browser: = 10MB

Windows Browser: = 10MB

Total Space Needed: 570MB

In this example, there should be plenty of space available on the CD-ROM to
contain the project.

Prepare the Staging Volume
Creating a Portfolio CD requires a volume for staging production. This volume can either be
a hard drive or fast removable media, such as a Jaz® drive. Jaz cartridges are convenient,
since you can remove the cartridge, store it in a safe place, and update it in the future for a
new CD. Some CD burning software also allows you to create a temporary partition on your
hard drive for the purpose of creating a CD-ROM.

Name the Staging Volume

Decide what name you want your compact disc to have, and name your staging volume the
same.

If you are creating a hybrid CD, you are much more limited in naming your volume. The
name you assign to the volume on the Macintosh side equates to the ‘CD Label’in Windows
operating systems.  CD labels can contain a maximum of eleven characters and spaces are
not allowed.  
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Loading the Content

Copy the necessary image files onto your staging volume. It is recommended that you create
an Images folder at the root of the staging volume which will contain all the media files you
will catalog. Within the Images folder you may want to create additional folders to catego-
rize your content. See the section “Folder Structure”, below, for suggestions on organizing
the images. 

Also copy the Portfolio Mac Browser folder from the Portfolio CPT CD to the root of the
staging volume. You may want to put a ReadMe file and other additional information files at
the root as well.  See the section, “ReadMe Documentation”, below, for more information. 

Folder Structure

Even though the user will access your files using Portfolio, you should arrange your folders
to allow for easy, efficient navigation in the operating system as well.
•  Folders should contain no more than 100 items. This reduces the time required to open the

folder.
•  Folders should be organized and named in a logical hierarchy of subfolders.
• You may want to separate the different media types into different subfolders, i.e.

“Movies,” “Illustrations,” “Photos,” etc.

Naming Your Files and Folders

The names you assign your files should incorporate a consistent naming convention that will
help the user locate the correct image. You may want to establish a naming convention that
incorporates your company name, or abbreviation, followed by a numerical suffix. Decide
which files you want to appear near each other (i.e. all pictures of beaches followed by
romantic couples on beaches), and name accordingly.

If part of your target audience is Windows 3.1 users, your folder names can be no longer
than eight characters. File names must adhere to the ‘8.3’naming convention. This means
file names can be no longer than eight characters long with a three character extension (such
as “img00123.jpg”). Windows 95 and Windows NT 4.0 both support long file and folder
names, so this need not be a concern. Be aware that Portfolio 4.0 does not operate under
Windows 3.1, but following this convention will allow the Windows 3.1 user to access the
image files.



9

Files that are going to be accessed via a Windows operating system MUST contain a file
extension at the end of the file name. This is the mechanism all versions of Windows use to
determine the file type of a file. Check the Portfolio User’s Guide for a list of some of the
more common Windows’ file extensions.

Be aware that Windows’systems have a diffferent set of acceptable characters for file
names. In particular, the following characters are not allowed:

\ / : * ? ” < > |

Also, do not use any of the Mac-specific option characters (those produced by holding down
the Option key on the Macintosh). For example, using the “ƒ” character (OPT-f) to label a
folder (such as “Images ƒ”), will not display correctly in the Windows operating systems.
When in doubt, try entering the file name on Windows to test its validity.

Consider Aesthetics

Arrange your Finder windows and their contents. Window placement, icon location, size,
view mode, and scroll box position are “remembered” when you write a CD. Here are a few
guidelines to follow.

Place often used, or important explanatory or declarative documents in the disc’s root level
(topmost) window. Typical examples would be Read Me files, license agreements, and the
Portfolio catalog.

The following steps can be followed to help organize the staging volume:
• Select “by Name” in the View menu.
• Option-click zoom box. (Repositions window and resets zoom box location. Be sure to

position the window near the upper-left corner of the screen for 640x480 monitors)
• Click the zoom box. (Window shrinks to optimum size.)
• Select “by Icon” the from View menu.
• Hold down the Option key and select “Clean Up by Name” from the Special menu.
• Select View by Name.
• Close the window.

The user’s window should automatically resize to show more (or less) information if they
are using a larger (or smaller) monitor.

Windows operating systems currently do not allow the CD-ROM producer to lay out folders
in this fashion, so the above steps will not be of use in Windows. This is a good reason why
you should develop a coherent hierarchy of folders to assist navigation in the operating sys-
tem.
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ReadMe Documentation

Create a ReadMe file for your customer. This should contain all the instructional information
regarding your content, including ordering information and keywording strategies that you
employed. Save the file in a format that the user will be able to read. Some of the more com-
mon formats are a text file, HTML file, or PDF file. If you create a PDF file, you should
include the Adobe Acrobat Reader. In most situations, Adobe Systems will let you distribute
this free of charge. Be sure to contact Adobe Systems for more information.

If you are creating a hybrid CD, be aware that text files are formatted differently on the Mac
and Windows and should not be used cross-platform. If you want to use a text file as your
ReadMe, it is best to reformat the file for each platform. This means that you will include a
different file on either part of the hybrid CD. Chapter 4, “Creating a Portfolio CD-ROM”
describes how you can do this. Regardless of the file format you use, make sure to append
the appropriate Windows’extension on the file so your Windows users will be able to open
it.
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3—Creating the Catalog

This section explains how to set up your Portfolio catalog for publishing on a CD-ROM. It
assumes that you are already familiar with how to use Portfolio. If you require more assis-
tance using Portfolio, refer to the Portfolio 4.0 Users Guide..

Install Portfolio

Run the Extensis Portfolio Installer on your CD. After the installation is complete, run
Portfolio from your hard drive.

Create a Portfolio Catalog

Launch Portfolio 4.0 and create a new catalog by selecting New from the File menu. Drag
the folder containing your source files into the catalog window. The Catalog Options dialog
will appear with the General tab selected. Choose the following settings:

General Tab
Modify Method Use Add/Update as your default.
Path as Keywords: Offers five options for using the filename and path as a keyword;

choose the one most appropriate for your situation. For example, if
the folder names in the path would make useful keywords, choose
“Path name”. If all of the folders have cryptic names or are all titled
“Images”, it is probably best to choose “None” or “File name”.

Thumbnail Quality Set this option to ‘Best’to ensure the highest quality thumbnails.

Thumbnail Size The default setting of 112x112 is normally the best solution. However,
if you have extra space on disk and would like to display the thumb-
nails at the larger 256x256 size, use that setting. Bear in mind that this
typically increases the average record size from 10K to 25K, so your
catalog file will increase in size more rapidly.

Rules Tab

As all of the files are being added to the catalog as new records, the only settings that matter
in this tab at this time are in the Add box.
Extract Keywords Enable this option if you have attached keywords to your source files

or entered them in an application such as Photoshop.
Extract Description Enable this option if you have attached descriptions to your source

files or entered them in an application such as Photoshop (this is the
Caption field in Photoshop).

Extract Thumbnail Enable this option if you have embedded thumbnails in your source
files.

Skip Files Enable this option if you want Portfolio to ignore files for which it
cannot find or create thumbnails.

In addition, you may want to use some of the advanced settings on the Mappings, File
Types, and Exclude tabs. Refer to the Users Guide for additional information on all of these
cataloging options. 

Click the OK button in the Catalog Options dialog to initiate the cataloging process.
Portfolio will now scan through the entire folder structure of your data, providing a total
count of the files found.  Portfolio then begins to catalog these files. 

It is wise to monitor the Cataloging process for unexpected behavior. If an abnormal number
of items are being skipped, you should cancel the process and double-check your settings.
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The amount of time required to create a catalog varies greatly from system to system.
Variables to consider are:
•  Number of items in the catalog.
•  Number and type of thumbnails being created for each item.
•  Number of keywords attached to each item.
•  Commonality factor of the attached keywords. The more common the keyword, the longer

it will take to index.
• The size and complexity of the source files.
• The speed of the drive(s) you are reading and writing to.
• The speed of your CPU.

Catalog Design Considerations

While Portfolio generates thumbnails for your images that allow for easy visual inspection
of the catalog by your users, you should also consider adding textual information to each
record in the catalog. While visual browsing is useful for examining a small subset of
images, providing textual information in the form of keywords and custom fields allows the
user to search a catalog to narrow the set of images to the point where visual browsing is
practical. Portfolio provides different options for displaying information, each of which pro-
vides different advantages to your user.

Keywords

Keywords are generally a list of attributes for each item. By assigning a consistent list of
keywords to each item, you provide a simple way for the user to find a subset of the catalog
whose contents have specific attributes in common. Portfolio allows you to add keywords to
items through a number of different methods. 

Note: For specific instructions on how to use the following features, refer to the Portfolio
User Guide.

Item Properties — Use the Keywords tab of the Item Properties dialog to edit the set of
keywords for a specific item. Though the other methods for keywording are generally faster
for adding keywords to a number of items at once, the Item Properties dialog gives you the
most control over each specific item. 

Edit Keywords — The Edit Keywords dialog allows you to assign and remove keywords to
multiple items at once. Therefore, if you have a set of items that all share particular attribut-
es, you can simply select all of them in a gallery and then open the Edit Keywords dialog to
add one or more keywords to all the items at once.

Master Keywords — In addition to adding keywords to each item, you can also generate a
Master Keyword List. When used properly, this list can represent all the possible keywords
available in a catalog. If you generate a master keyword list prior to assigning keywords,
you can display the master keywords in the floating Master Keyword Palette. It then
becomes a simple drag-and-drop procedure to assign one or more keywords to one or more
items. By dragging master keywords to an item’s thumbnail, you assign those keywords to
that item. Not only is this the fastest method for adding keywords, but it also prevents typos
and ensures consistency between items.

Master Keywords are not only useful during the production process, but they are a valuable
resource for your customer as well. If the Master Keyword Palette represents all the key-
words used in a catalog, then the user can simply scroll through the palette and double-click
on a Master Keyword to display all the items that have been assigned that keyword. Thus,
instead of having to guess what words you have assigned to the items in the catalog, the user
has a list showing them all of their options.
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To create a Master Keyword List from scratch, simply open the Administration tab and enter
keywords on the Master Keywords tab. If you are going to be working with multiple cata-
logs, you can export the Master Keyword list and then import it into future catalogs’master
keyword lists. This will ensure not only consistency within one catalog, but consistency
across an entire line of catalogs.

If you have already keyworded the items in the catalog using other means, you should still
consider generating a Master Keyword List. Portfolio provides a simple process to automate
this procedure.
1.Open the Catalog Properties dialog and select the Statistics tab.
2.Click on the ‘Calculate’button to generate a list of all the keywords assigned to all the

items in the catalog.
3.Click on the ‘Export’button to save the list to a text file.
4.Close the Catalog Properties dialog, and open the Administration dialog.
5.Click on ‘Import’and select the text file you saved to disk in step 3. Your Master

Keyword List has now been populated with all the keywords currently in your catalog. 

Custom Fields

In addition to keywords, Portfolio also gives you the opportunity to define your own custom
fields. Custom fields are commonly used when all the items all have a particular attribute.
Some common examples of custom fields are Photographer, Production Date, Part Number,
and Price. Custom fields have two advantages over simply adding assigning more attributes
to a list of keywords. 

First, a custom field can provide context and meaning to a word. For example, the keyword
‘Washington’can be quite ambiguous for your user; the word could refer to the name of the
photographer, the name of the subject, or the shoot location. Such problems become even
more confusing when using dates and numbers.

Second, when used in conjunction with Portfolio’s customizable display capabilities, custom
fields allow you to display specific pieces of information below the thumbnail. Instead of
being one of many attributes listed in Keywords, the attribute can now be displayed in its
own field. For more information on customizing the view, refer to the section, “Customizing
the Display”, later in this chapter.

When creating custom fields, you have several options. You can select what type of informa-
tion will be contained in the field (the data type), and whether it will contain multiple pieces
of data (as a multi-valued list), or just a single piece of data. When deciding whether to
index a custom field, consider how it will be used by the user. If the purpose of the field is to
provide another mechanism for searching the catalog, index the field for greater speed when
executing searches. On the other hand, if the purpose of the field is to display a piece of
information (that would not be searched), you do not need to index the field. This will result
in a smaller catalog.

Descriptions

The description field for each item is an unindexed text block that can hold roughly 32,000
characters. As such, it is very useful for holding large amounts of text that the user may want
to read after finding the image. Good uses of the description field would be to contain copy-
right information or background material for the image. Portfolio does allow the user to
search this field, but because it is unindexed the search can take quite a bit longer than a
search on an indexed field (particularly if many of the items contain a great deal of text in
this field).
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Customizing the Display
Portfolio offers you the opportunity to customize the presentation of your collection. Using
the Saved Galleries and Customize features, you can control which images the user will see
and the formatting of the view of these items.

A saved gallery can be any subset of the items in the catalog. One of the most common uses
when creating a CD-ROM is to create a default gallery. This is the gallery that is loaded
each time the catalog is open. To create a default gallery, simply save a gallery titled
“Default”. 

Using the Customize command in the View menu, you can change how the images in the
default gallery (or any gallery) are presented. For example, you may want to display the
images on a black background. If you have added custom fields to the catalog, you may
want to display these pieces of information below the thumbnail instead of the standard
fields. You can also create borders that surround each thumbnail for a more polished look.
For more information on how to use these features, refer to the Portfolio Users Guide.

Customizing the Catalog
Portfolio 4.0 has a number of features that were specifically designed with the Content
Publisher in mind. Depending on your target audience, you may want to consider using such
features as the Custom Splashscreen and launching the Slideshow when the catalog opens.
These and other options can be set on the Administration - Startup tab.  For more informa-
tion on how to use these features, refer to the Portfolio Users Guide.

Setting Access Privileges

Though it is not very common to restrict access in a published catalog, you may want to
consider setting passwords on the catalog. This can be useful if you do not want your cus-
tomers to manipulate the catalog. To set passwords for the different access levels, open the
Administration dialog and select the Passwords tab. For information regarding which fea-
tures are disabled under different access levels, refer to the Portfolio Users Guide.

Note: This is not normally an issue, since the catalog will be on a read-only CD that the
customer will be unable to modify. Only if the customer copies the catalog can there be any
possibility of it being modified. Also be aware that password protecting the catalog will in no
way protect your images from being modified if they are copied off of the CD-ROM.

Updating the Catalog
It is usually necessary that the catalog be updated prior to burning the CD. If the images
have been moved during the process of creating the catalog, or if you have created parts of
the catalog by copying items into it from another catalog,  you will need to update the cata-
log to ensure that all the links are pointing to the location on the drive from which you are
planning to burn.

To update the catalog, simply drag the entire Images folder onto the open Portfolio catalog
window. This will result in the Catalog Options dialog being displayed. For best results, use
the following settings:

• MacOS File Sharing: This system option must be turned off. Portfolio records the loca-
tion of a source file differently depending on whether the MacOS File Sharing is turned on
or off. With File Sharing on, Portfolio assumes the source files are to be shared over a net-
work, and therefore records the network pathname, which includes the name of the com-
puter before the volume name. This will result in problems when the final CD is loaded on
the customer’s computer, so you must turn File Sharing off. File Sharing can be disabled
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in the Sharing Setup control panel.
• Modify method: Set this pop-up in the Cataloging Options - General tab to “Update

Unconditionally”. This will cause only existing items to be updated; no new items will be
added to the catalog.  By using “Update Unconditionally”, Portfolio will skip some checks
that would prevent the records from being relinked to the staging volume.

• Regenerate Thumbnail / Extract Description / Extract Keywords: Turn off all of these
options in the Cataloging Options - Rules tab, in the Updating box. Because you already
extracted any of this information in the original cataloging process, you do not need to
repeat this step. Turning off these options will speed the Updating process.

Following the steps above should help ensure that the items in the catalog are now linked to
the staging volume. It is still advisable to verify that the catalog is complete by following the
steps outlined in the following section.

Inspecting the Catalog
Portfolio offers several different tools to help you verify that the catalog is complete. The
checks outlined below will help you avoid common pitfalls that can cause undesired results
on the final CD.

Check for Poor Thumbnails

Some applications store smaller thumbnails than Portfolio generates. This can be distracting
or confusing for the customer. If you notice that some thumbnails appear undersized, you
can force Portfolio to generate its own thumbnail for that item (assuming Portfolio can gen-
erate a thumbnail for that file type). To update such an item, locate the original file and drag
it onto the open Portfolio gallery window. In the Catalog Options dialog, set the
Modification Method to “Update Unconditionally” and disable the Extract Thumbnail
option. Also turn off the Extract Keywords and Description options for the same reason
described in the previous section, “Updating the Catalog”. The Update Unconditionally set-
ting causes Portfolio to regenerate a thumbnail for that image, and turning off the Extract
Thumbnail option will cause Portfolio ignore any embedded thumbnail in the source file.

Check for Extra Volumes

Because some of the source files may not have been copied to the staging volume or were
not updated once they were copied to the staging volume, it is important to verify that all the
items in the catalog point to the staging volume. To do this, select “Catalog Properties…”
from the Catalog menu and click on the “Statistics” tab. Click on the “Calculate” button.
After processing, Portfolio will list all the volumes referenced in any of the pathnames of the
items in the right-hand list box. If the catalog has been properly created and updated, the
only volume being displayed should the the name of the staging volume (and the eventual
name of the CD). 

If any other volumes are listed, do a search for each volume name using the Find dialog. The
most common reasons other volumes are showing in the list are because either the original
file was not copied to the staging volume, the catalog was not updated after the file was
moved, the orginal location still existed when the file was updated from the staging volume,
or the item is simply an extraneous file that does not belong in the catalog. After you deter-
mine what the cause of the problem is, you can either remove the item from the catalog or
update it properly.

Check for Broken Links

Even if all of the items reflect that they are linked to the staging volume, there still may be
broken links in the catalog. These can occur if the original files are moved on the staging
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volume after the catalog has been updated.

To check for broken links, use the Missing Files command in the Catalog menu. This func-
tion generates a list of all items for which Portfolio cannot find the original file based on the
path recorded in the catalog. If any items are listed in this dialog, select them and then
choose update to locate each missing file on the staging volume.

Note: It is not sufficient to use just this command and not the Statistics command, since
Portfolio will not report missing files in the Missing Files dialog if the volume cannot be
located. Therefore, the Statistics volume list may indicate undesirable files in the catalog that
the Missing Files command would not display.

Check for Proper Pathnames

Finally, in order to verify that all items have been updated without File Sharing on, switch to
List view and quickly scroll through the pathname field to verify that all of the paths begin
with the name of the staging volume and none of the paths contain the computer name.
These items will not show up in the Missing Files dialog because they are proper pathnames
as long as the volume remains in use only on your computer. If any files are found that do
contain the computer name, update the items again following the steps outlined in the sec-
tion above, “Updating the Catalog”. 
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4—Burning a Portfolio CD-ROM
This chapter covers the actual process of burning a CD-ROM with a Portfolio catalog and
tests you can use to verify the CD after it has been produced. Adaptec’s Toast CD-writing
software is used in the instructions to illustrate the CD-ROM burning process; however,
Extensis does not recommend any particular CD-writing software and other software pack-
ages should perform similarly.

Final Preparations
If you have followed the instructions throughout this manual, the staging volume should
contain the Portfolio catalog, the Portfolio Mac Browser folder, your Images folder, and any
other files you consider necessary for your customers.

Inspect the volume to make sure that all the files are arranged correctly and named properly.

Setting up the Windows-only Files

If you are creating a hybrid CD, you’ll need to identify the files that will be used exclusively
on the Windows portion of the CD-ROM. At a minimum, you will need the Portfolio
Windows Browser folder. You may also have other files, such as a Windows-specific
ReadMe file. Gather these files together into a folder on a volume other than the staging vol-
ume (the staging volume must contain only files that are to be used exclusively on the
Macintosh and files that will be shared between both platforms). 
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Burning a Macintosh-only CD-ROM
The steps for the actual production of a Macintosh-only CD-ROM are relatively simple.

1. Launch Adaptec Toast (or similar CD-writing software)

2. Choose “Mac Volume” from the Format menu.

3. Drag the entire staging volume from the desktop to the “Mac Volume” box of the
Toast window.

It should now display the name of the staging volume in the box, along  with the size of
the volume.

4. Click on the “Write CD…” button.

If there is no blank CD in the CD-R drive, you will be prompted to insert a CD. 

5. Click on the “Disc” button to begin the burning process.

Writing a multi-session Portfolio CD-ROM is not recommended.

When the writing and verification passes are complete, eject the disk and skip to the section
“Testing the CD”, below.
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Burning a Hybrid CD-ROM
The steps for the creating a hybrid CD-ROM are not much more difficult than a Mac-only
CD.

1. Launch Adaptec Toast (or similar CD-writing software)

2. Choose “Mac/ISO-9660 Hybrid” from the Format menu.

3. Drag the entire staging volume from the desktop to the “Mac / ISO Hybrid” box of
the Toast window.

It should now display the name of the staging volume in the box, along  with the size of
the volume.

4. Click the “ISO” button.

This will open up into a dialog where you can lay out the Windows portion of the CD.

5. On the Files tab, click on the “New Volume” button and name the volume the exact
same name as the staging volume.

6. Drag the Windows-only files from the Finder into the window.

7. In the Finder, open the staging volume and drop the Images folder and the Portfolio
catalog file into the window.

Shared files (but not shared folders) will be displayed in blue. Repeat this step for any
other files you want to share across platforms (a ReadMe in PDF format, for example).

The illustration above shows a typical configuration. The catalog is displayed in blue,
indicating that it is shared. The Images folder is also shared, but because it is a folder, it
is not displayed in blue. Expanding the Images folder would reveal that the image files
inside are displayed in blue.

It is critical at this point to verify the path to the images folder. The hierarchical layout
displayed in this window must match the structure created on the staging volume. In
other words, if the Images folder is at the root of the staging volume, it must also be at
the root of the Windows portion. All the files and folders in the display can be moved up
and down the hierarchy, and new folders can be created using the “New Folder” button.

8. Switch to the Settings tab.
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9. Set Format to “CD-ROM” and Naming to “Joliet”. 

This allows you to have long names, but the CD can still be mounted by Win 3.1 sys-
tems.

Note:  The Joliet option is not available in versions of Toast prior to version 3.5. In this
situation, you have two options:

1. If you have followed the steps to prepare the CD for Win 3.1 (short file names, etc)
choose the MS-DOS option. 

2. If your file names have long file names, choose the Macintosh file names option. Be
aware that this will result in a CD that is unusable by Win 3.1 systems.

10.Click on the “Done” button to exit the dialog.

Back on the main screen, you should now have information filled out for both the Mac
and ISO portions of the CD-ROM. Verify that the volume name displayed for the Mac
portion exactly matches the volume name for the ISO portion.
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11.Click on the “Write CD…” button.

If there is no blank CD in the CD-R drive, you will be prompted to insert a CD. 

12.Click on the “Disc” button to begin the burning process.

Writing a multi-session Portfolio CD-ROM is not recommended.

When the writing and verification passes are complete, eject the disk and proceed to the sec-
tion “Testing the CD”, below.

Testing the CD
Once the CD-ROM has been burned, you need to test it to verify that it works as expected.
Before testing, make sure the staging volume has been unmounted. If the staging volume is
mounted, this could result in inaccurate results, since the catalog on the CD could still be
referencing files on that volume (since it has the same name as the CD you created). 

1. Mount the CD on a Mac to verify that the CD is readable.

2. Double-click on the catalog on the Mac.

If a full version of Portfolio has launched, then this is most likely because you have a
pre-existing Portfolio installation on the system. Either conduct the tests on a Mac that
does not have Portfolio installed, or drag the catalog onto the Browser application on the
CD.

3. Run through the same tests listed in Chapter 3, in the section “Inspecting the
Catalog”.

Use these tests to verify that all the changes that were made during the update process are
showing up in the final catalog.

4. Double-click on each image in the catalog.

Though this may seem like overkill, this will verify that all the links to all images are
correct, and it will ensure that the images were written to the CD-ROM properly.

5. For a hybrid CD, run through all of the above tests on a Windows system.

If you are burning a cross-platform CD, this is necessary for testing. Do not assume that
a CD that works correctly on a Macintosh will work properly on a Windows PC (there
are many reasons why it may not). Do not rely upon Windows CD mounting software for
the Macintosh or Windows emulators to test the CD, either.
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